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1 Introduction
u-create studio is a tool suite for automation tasks.

Information
This product includes software developed by the EclipseTM Project (http://
www.eclipse.org).

This product also contains software that was developed by third parties.
The open source software programs are protected by copyright. The open
source software can be used in accordance with the respective open source
software license conditions. If the open source software license conditions
and the applicable Weidmüller license conditions for the product conflict with
regard to the open source software, then the open source software license
conditions take precedence. The open source software is provided at no
cost. If the applicable open source software license conditions allow, the
software source code can be requested via the Weidmüller website within 3
years after purchase of the product. Shipping costs apply. Weidmüller is li-
able for the product including the open source software contained in it in ac-
cordance with the valid license conditions for the product.

Information
Any liability for the use of the open source software beyond the scope of
the program sequence provided by Weidmüller for the product as well as
any liability for defects caused by changes to the open source software is
excluded. Weidmüller provides no technical support for the product if this
was modified.

You can find additional information about the open source programs and li-
censes of Weidmüller products on the Weidmüller website in the service
area.
A directory with the Open-Source software terms of a licence contained in
this product can be opened via the About dialog of the tool.

1.1 Preconditions

This document contains information for persons with the following skills:

Target group Prerequisite knowledge and abilities

Project engineer

Basic technical training (technical college, engineer training or corre-
sponding professional experience).

Knowledge about:

● Current valid safety regulations,
● method of operation of a PLC and
● the application.

http://www.eclipse.org
http://www.eclipse.org
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Target group Prerequisite knowledge and abilities

Programmers

Basic technical training (technical college, engineer training or corre-
sponding professional experience).

Knowledge about:

● Current valid safety regulations,
● method of operation of a PLC and
● programming of a safe PLC.

Start-up operator

Basic technical training (technical college, engineer training or corre-
sponding professional experience).

Knowledge about:

● Current valid safety regulations,
● fundamental validation concepts according to EN ISO 13849,
● method of operation of the machine or system,
● fundamental functions of the application,
● system analysis and troubleshooting and
● setting options on the operating devices.

Service technician

Basic technical training (technical college, engineer training or corre-
sponding professional experience).

Knowledge about:

● Method of operation of a PLC,
● current valid safety regulations,
● method of operation of the machine or system,
● diagnostic options and
● systematic fault analysis and remedial action.

1.1.1 Required Hardware
Standard Windows® PC.

1.1.2 Required Software
● Windows 10®

1.2 Intend use

This product was developed for the configuration, programming, and diag-
nostics of the Weidmüller system and thus is used for the realization of auto-
mation solutions.

1.3 Information about this document

This manual is an integral part of the product. It is to be retained over the en-
tire life cycle of the product and should be forwarded to any subsequent
owners or users of the product. For end users, necessary safety notes and
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information must be integrated in the instruction manual for end users in the
specific national language by the mechanical engineer or the system
provider.
This documentation must be legible and available to the specified persons
and must be read and understood by them.

1.3.1 Contents of the document
Description of the:
● u-create studio user interface,
● Creation of projects using templates,
● Configuring devices
● Diagnostic options

1.3.2 Not included in this document
● Programming of control or operating devices,
● Configuration of panels or operating devices in the control,
● Working with additional tools for the control programming,
● Detailed description of the bus systems,
● Programming of C and C++ programs.

1.4 Additional documentation

The following documents are referenced several times below.

Designation Target group

Delivered System Manual

● Project engineer
● Electrician
● Programmer
● Start-up operator
● Service technician

For basic knowledge about the Ethernet-based fieldbus EtherCAT, we rec-
ommend the following sources:
● EtherCAT Technology Group (ETG): http://www.ethercat.org

http://www.ethercat.org
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2 Safety notes

2.1 Representation

At various points in this manual, you will see notes and precautionary warn-
ings regarding possible hazards. The symbols used have the following
meaning:

DANGER!
indicates an imminently hazardous situation, which will result in death or se-
rious bodily injury if the corresponding precautions are not taken.

WARNING!
indicates a potentially hazardous situation, which can result in death or seri-
ous bodily injury if the corresponding precautions are not taken.

CAUTION!
means that if the corresponding safety measures are not taken, a potentially
hazardous situation can occur that may result in slight bodily injury.

Caution
means that damage to property can occur if the corresponding safety mea-
sures are not taken.

ESD
This symbol reminds you of the possible consequences of touching electro-
statically sensitive components.

Safety information
Describes important safety-related requirements or informs about essential
safety-related correlations.

Information
Identifies practical tips and useful information. No information that warns
about potentially dangerous or harmful functions is contained.
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3 Installing u-create studio
Please note the system manual and the manual controllers u-control.
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4 User interface
This chapter describes the user interface of the u-create studio.

4.1 Operation

Standard functions under Windows® such as drag & drop, copy & paste, indi-
vidual adaptation of the user interface by docking, pinning of windows and
menu bars are known by nearly all PC users and can be easily learned by
simply trying them out.
They are therefore not described in more detail in this document. We refer to
the literature provided on the Internet about the listed topics.
General operating information
As with almost all Windows tools:
● Double-clicking on a created object will open it.
● Right-clicking the mouse will open a context menu.
● Some context menus are not always available and written in gray. When

certain conditions are fulfilled these menus turn active.

4.2 General view

The following graphic shows the standard view (perspective) of u-create stu-
dio. The arrangement of the windows can, however, be changed according
to your individual requirements.

Fig. 4-1: u-create studio User interface

1  ... Menu 2  ... Tool bar
3  ... Project tree 4  ... Work area
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5  ... Variables browser 6  ... Watch Monitor
7  ... Message window 8  ... Action Log

4.2.1 Menus and toolbar
The useable commands in u-create studio can be activated from the menu
bar, the tool bar or from context menus.
Only u-create studio-specific commands are described here. For the benefit
of a better overview, the explanation of generally known standard com-
mands will be dispensed with.
The following tables show an overview about the u-create studio-specific
menus.

Menu "File"

Menu command Shortcut Meaning
File - New project... Strg+N Create new project.

File - Open project... Strg+O Open existing project.

File - Save project Strg+S Save current project and generate
configuration files.

File - Project Archive - Extract ar-
chive - Extract a project archive including

the devices used.

File - Project Archive - Save ar-
chive - Save project archive

Menu "Project"

Menu command Shortcut Meaning

Project - Set active application - Select the application which should
be loaded to the control.

Project - Export - Export entire project

Project - Import - Import a file

Menu "Tools"

Menu command Shortcut Meaning

Tools - Device repository - Install and uninstall device descrip-
tion files.

Tools - Scripting - Execute Script
File... - Execute Python Scripts to configure

devices

Tools - Scripting - Enable Script
Tracing - Check configuration of the devices

made by Python Scripts

Tool bar
The toolbar also contains the following standard icons, such as for example
for the creation, opening or saving of projects.
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4.2.2 Project tree
The project tree shows the current project and the devices contained in the
project. Double-clicking on an entry opens the associated work area or the
associated editor.

Fig. 4-2: Project tree

The elements in the project tree are depicted in a logical sequence (e.g. ad-
don capable modules under bus system, bus system under CPU, etc.) and
can only be inserted in the specified sequence. Double-clicking on the de-
sired element opens the matching configuration in the work area. By clicking
on an already selected hardware component in the project tree, you can
modify the name of the device.
Context menus in the project tree
Depending on which element is selected, the project tree contains different
commands in the associated context menu (accessed by right-clicking on an
entry in the project tree).

4.2.3 Work area
In this area, the configuration of the device selected in the project tree is dis-
played and editable.

4.2.4 Variable Browser
Is used for displaying embedding system variables of IEC application into
the project. The variables are shown in the variable browser with its directory
structure, as soon as there is a connection and login to control. The shown
variables can be used in the watch monitor.

4.2.5 Watch Monitor
Variable from variable browser can be analysed here (name, type, value,
predefined value, path, comment).

4.2.6 Messages
Errors, warnings and messages are displayed here.
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4.2.7 Action Log
In the "Action Log" are the actions from the user and the implicit actions from
the system logged. This can be used to get an overview of the actions.
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5 Create project
In addition to the required steps for creating a project, this chapter also de-
scribes additional, important functions for the project administration (export-
ing/ importing project, managing device description files).
In general, a complete configuration requires the following essential steps:
1) Create new project (Empty or pre-defined Template)
2) Insert devices (+ shift, copy and delete)
3) Configure devices
4) Mapping endpoints
5) Insert existing symbol files
6) Create IEC application

5.1 Create new project

In order to create a configuration of devices, a project must be created.
To create an empty project, proceed as follows:
1) Start u-create studio and call up  File ► New project via the main

menu.

Fig. 5-3: Project creation window

2) In the creation window select category "General" and as template
"empty project". The number of chooseable categories and templates
may vary. Enter a project name (e.g.: Projekt1) and specify a storage
location.

3) Confirm your entries with OK.
The project was created and appears in the project tree.
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5.2 Insert devices

In order to create a configuration, the required devices must be inserted into
the project tree.

Actions for inserting devices

The following actions are available for inserting devices:

Action Description

Add device The new device will be subordinated to the selected de-
vice.

Insert device The new device will be inserted after the selected device,
on the same level.

Information
f a device is added into the project tree an instance of the function block of
the respective device type will be created automatically. The device name
will access the instance.

To insert a device, proceed as follows:
1) In the project tree select the node of an interface at which a new device

is to be appended and select in the context menu Add Device
2) The opened dialog contains the possible devices for selection (depend-

ing on the selected element in the project tree). Select the desired de-
vice and add it to the project via Add Device  or double- click.

The device is inserted at the corresponding position into the project tree.

Information
The "Add Device" window can remain open while you navigate in the
project tree. The list of devices changes according to the selection without
having to reopen the window. This permits assembling the project quickly
and easily.

Shift, copy devices

The arrangement of the elements in the project tree can be modified by cut-
ting, copying, pasting and by Drag&Drop. The elements can only be ar-
ranged in the appropriate logical order.

Delete device from the project tree

To remove a device from the project, select it in the project tree and click in
the context menu on delete.
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Information
If you delete a device, all subordinate objects are also removed. This action
can be undone with Edit - Undo.

Update device

Devices can be updated to a newer version or to a different type. Similar to
Add Device is Update Device in the context menu.

Information
When changing the type of the device all settings will be lost and the sub-
devices can be preserved only in certain cases. This also applies to de-
vices with small differences.

5.3 Configure devices

The inserted devices can be configured depending on the setings. For fur-
ther information see "Configuration of devices".

5.4 Insert existing symbol files

If symbol files are already existing (e.g. from u-create studio C++ or manu-
ally created files) those can be inserted into u-create studio.
This happens via right mouse-click on the control in the project tree and se-
lecting Add object ► Symbol file.... The path of the desired symbol file is
inserted in the opened window. Via Add the symbol file is added to the
project.
This can be repeated for several symbol files.
When generating the project all variables of inserted symbol files or symbol
configurations within the project are written into a single symbol file. This file
is then available for e.g. the visualization application.

5.5 Mapping endpoints

Each device with endpoints features the tab I/O Mapping in the configura-
tion window.
System variables of the IEC application can be mapped in this tab to HW
endpoints (assuming a suitable data type). Therefore variables are allocated
for the desired inputs and outputs which will be created automatically after
saving. This variables can be used in the IEC application.
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Fig. 5-4: I/O Mapping

Depending on the type of I/O module, channel-specific features can be acti-
vated, deactivated and parameterized separately for each channel using
drop-down menus or text input fields.

Fig. 5-5: Additional settings or DIs

Fig. 5-6: Features checkbox in IO Mapping

Some modules have parameters that are not channel-bound, e.g. the 1SSI
module.
The tab also offers the option to permanently override its endpoints for the
runtime (forcing). For that, you can enter the desired value in the column
"Force Value" and then activate the column "Force" with the help of the
slider. As long as the value is activated with the slider, the endpoint main-
tains the set value.

Information
The values in the "Value" column are the values that the IEC application
assigns to the endpoints.
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5.5.1 Printing endpoint mapping
The mapping of the endpoint can be printed for easier wiring. To do so, the
print function must be used via File - Print.
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6 Loading project on control
With u-create studio the project can be downloaded to a control. For the on-
line option, you need to establish a connection to the running control first.

6.1 Establishing Connection PC - Control

Double-click on the node of the control in the project tree to open the editor
with the configuration of the control. There is also an individual "Communica-
tion Settings". A connection to the control can be created there.

Fig. 6-7: Communication settings

Fig. 6-8: Tool bar of the communication settings

1  ... Add new device 2  ... Search network
3  ... Make device active 4  ... Configure device
5  ... Remove device

Direct connection PC - control

To establish a connection the PC must be plugged into the control.
Proceed as follows:
1) Click on "Scan" on the tool bar to start the automatic search run which

searches the network for devices. Found controls are added to the area
"Available Controls".



Loading project on control

24

2) Upon completion of the search run you can select the searched control
in the tree and activate it in the project via the tool bar with the help of
"Set Active". This establishes the connection to the control and the sta-
tus of the control is already indicated in the project tree. Alternatively,
you can also set a found control to active by double-clicking on it.

If the desired control was not found during scan, it can be added by Add De-
vice and then activated like mentioned before.
When connecting to the control the devices configured in u-create studio
may not accord with the real hardware.
Via Device manipulation in the context menu of the control the following
manipulations can be done:

Fig. 6-9: Device manipulation example

Manipulation Description
Stop Application Stops applications (IEC) on the control

Restart Applications Restarts applications (IEC) on the control

Stop Controller Stops control process

Restart Controller Restarts control process

Reconfigure Controller

Shutdown Controller Shutdown control

Reboot Controller Restart control with operating system

Those manipulation possibilities are dynamic and depend on the current op-
erating state of the control.
Furthermore the main operating state are displayed in colors and textual in
the project tree if a connection is established. Thereby the following state are
possible:

Color Text Description

Blue

INIT

or

OsReady

Control in start-up

or

Operating system started (application has not been
started)

Green RUN Control is running

Red EXCEPTION Error
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To exit the error state of the control the context menu of it has to be opened
in the project tree and the control process must be stopped via Device ma-
nipulation - Stop Controller. Then the application must be deleted with De-
vice manipulation - Delete Application. After successfully deleting the ap-
plication the control process can be restarted via Device manipulation -
Start Controller and a new application can be downloaded to the control.
Change selected control
If a connection to a different control should be established this can be done
in u-create studio in the communication settings.
Proceed as follows:
1) Open the settings via double click on control in the project tree.
2) Change to tab Communication settings and select the control in the

list.
3) Open the configuration dialog via click on Configuration.

Fig. 6-10: Change IP- address

4) Enter IP address of the desired new control and confirm with OK.
A connection to the new control is established.

6.2 Logging in on the Control

To use diagnostic features or to update the OnlineChange capable applica-
tion parts, you must execute a login.
The configured devices inu-create studio must be the same like real devices.
If this is not the case the login attempt can be canceled.
For a login proceed as follows:

1) Click in the Online - Login menu or alternatively on the respective 
button in the toolbar.

2) The Login dialogue requires the entry of a user name and password (de-
fault: Administrator/tobechanged). This user data can be encrypted and
saved by selecting the option "Save Settings" so the login data does not
need to be entered again.
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Fig. 6-11: Authentication during Login

3) After the login you will automatically be given the option to execute an
OnlineChange.

Fig. 6-12: OnlineChange if parts of project are capable

After a login and OnlineChange of the application to control is done, informa-
tion of application (e.g. values of variables) are available in u-create studio.
Furthermore different manipulations of application during runtime are possi-
ble (e.g. force of variable values in watch monitor).

6.3 Download to Device

To download the whole project to the device the command Online ► Down-
load and Login to Device or Selective Download to Device can be used.
The Online ► Login does only changes for OnlineChange capable project
parts.

Fig. 6-13: Download options
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At Download and Login to Device the whole project will be automatically
downloaded to the device and a login will be performed. In this process all
builds and generate processes will be executed to get the latest version of
all project parts to the device. This option is only available in specific sys-
tems.
At Selective Download to Device a dialog will show the elements of the
project from which the parts for download can be selected.

Fig. 6-14: Selective Download

After the selective download no login will be performed.

6.4 Loading additional files to device

It is possible to load additional files (e.g. further configuration files) onto the
device. For this purpose, a specific directory structure must be created in the
project directory in which the additional files can be stored.
The directory structure must look like this:

Project // Directory in which the u-create studio project is stored
    MyProject.project // u-create studio project
    MyProject // Directory has the same name as the u-create studio project
        MyDevice // Directory has the same name as the master device
            AddFilesForExecutableSystem
                appldisk
                masterdisk // optional directory
                workspace // optional directory

Files that should be considered when downloading to the device are stored
in the directory appldisk. The files stored here can be downloaded to the
device via selective download. The files are then also located in the appld-
isk directory on the device. Alternatively, the files can also be stored in one
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of the two optional directories masterdisk or workspace. After a selective
download, the files are also located in the masterdisk or workspace direc-
tory on the device.

Fig. 6-15: Selective download
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7 Open project from device
A project archive that was downloaded during download can be uploaded
and opened with File ► Open Project from Device .... In the following dia-
log the device from which the archive should be loaded can be selected.

Fig. 7-16: Open project from device

The desired device can be selected from the result list of a device scan or
added directly with "Add Device". After pressing the button "Open" the user-
name and password must be entered.
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8 Export and import projects
Parts of the project or the entire project can be exported and reimported into
a file. This allows you to reuse already created configurations and exchange
these between two projects or backup projects.
Export project
To export part of a project or an entire project, proceed as follows:
1) In the menu, select Project - Export.... A selection dialog opens.

Fig. 8-17: Selection dialog

2) Select the parts to be exported.
3) Confirm your input with OK.
4) Now select a file name and a location and save it.
The desired configuration was exported successfully as a file.
Import project
To import a backup configuration, proceed as follows:
1) Open the menu on Project - Import... and select the desired file.
2) In the opened window "Import" you can now select the items to be im-

ported.
The imported selection is added below the node that is currently selected in
the project tree.

8.1 Create project template

u-create studio offers the possibility to save existing projects as templates
for further projects. Templates are stored i <Installation directory>
\...\ Templates.
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A template consists of the following files:

File Description
<TemplateName>.project Project file copied from an existing project

<TemplateName>.template XML file with text for template name, .... in different
languages.

To create a template, proceed as follows:
1) Open or create a project that will be used as a template later. Devices

can be added and parameters can be configured here too.
2) Save the project.
3) Close u-create studio.
4) Copy the saved project file <name>.project from the project folder of

the sample directory and rename it to <TemplateName>. project.
5) Copy file ..\EmptyProject.template (in the same directory), rename

the copy to <TemplateName>.template.
6) Open the just created <TemplateName>.template file with a text editor

(such as Notepad). This file is an XML file that contains texts for the tem-
plate in different languages. It consists of the following three main com-
ponents:

Explanation of the XML tags

XML tag Description
<Name> Name of the template

<Description> Description of the template, appears as information while
creating a project

<DefaultFileName> The prefix for names of new projects

Each component contains XML tags with the text in different languages:

Explanation of the XML tags

XML tag Description
<DefaultString> English text

<LocalizedString culture='de'> Text in another language, the language is always specified
in culture . In this case, it is de for German

Adapt the contents of the XML tags as needed. The > and < symbols must
not be used in the text.
7) Save the file.
8) Start u-create studio.
The template is now available to create a new project.
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9 Managing packages
Furthermore, it is possible to manage device description files as well as plug-
ins that are available in the u-create studio by installing or uninstalling pack-
ages via the Package Manager. A package includes several device descrip-
tion files and library files and offers the advantage that complete system con-
figurations can be installed in one step.

Fig. 9-18: Package Manager

The package manager can be opened in the menu via Tools - Package
Manager.
ÜThe packages can be installed via the button Installierenand can be unin-
stalled via the button Deinstallieren. The file extension of such a package
file is .package.
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10 Create and execute the simulation of a control
It is possible to create and execute a simulation of the control using u-create
studio.
The simulation service must be installed and started. This is usually done
automatically by the general setup.
In order to be able to simulate a project, the device in the device tree must
first be changed to the simulation device. The device description file must be
exchanged to the simulation device ([device name]-Simulation) using "Up-
date device".

Information
Before downloading to the real device, the device description file must be
exchanged to the one corresponding to the real hardware. Otherwise the
device will run into an error condition after download!

10.1 Create simulation

To create the simulation, open the context menu of the PLC and select the
menu item Create Simulation or select the menu item Manage Simula-
tions in the toolbar.
This opens a dialog in which the following configurations can be carried out.

Fig. 10-19: Dialog for the creation of a simulation

Name Beschreibung

Name/PLC Name

This name will be used to identify a simulation for start and stop.
The name must be unique and the dialog will assist by showing
an information if a name is already in use. This name will also
be used in the communication settings to set the simulation ac-
tive.
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Name Beschreibung

Description An additional information that can help when managing simula-
tions.

Optional Packages The optional PLC packages which should be used can be se-
lected in the following dialog.

Location

● Managed by simulation service: with this option the created
simulation will be stored in a directory on the machine
where the service is hosted.

● Local storage path: a local path can be set where the new
simulation will be stored. Nevertheless a local simulation
service is necessary to run a local simulation.

A local simulation will only be visible in the u-create studio
in Manage Simulations if the simulation is running.

Build settings Depending on the used devices and features in the project will
be the build settings available.

The simulation will be created via Create.

10.2 Execute simulation

The button Manage Simulations  in the toolbar opens the following dia-
log.

Fig. 10-20: Dialog for managing simulations

The list in that dialog shows all simulations from the simulation service. The
buttons in the ribbon can be used for the following actions.

Name Beschreibung

Start Starts the selected simulation. This simulation is then available
in the communication settings.

Stop Stops a running simulation.

Create Opens the dialog for simulation creation.

Clone Creates a copy of the selected simulation.

Rename
Changes the name of the simulation. This name will also be
used for the PLC name which is visible in the communication
settings.
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Name Beschreibung
Remove Deletes a simulation.

10.3 Execute local simulation

To execute a local simulation the .exe file in the simulation directory must be
executed.

Fig. 10-21: Directory of a local simulation

A window will be opened with the informations of the simulation. If the simu-
lation contains a visualisation, it is started automatically. In the following im-
age the dialog with the informations of the simulation is visible with the visu-
alisation in the background.

Fig. 10-22: Local simulation with visualisation

If the visualisation window gets closed, it can be started again by clicking the
link in the bottem left corner.

10.4 Execute simulation from flash

With u-create studio it is possible to run a flash as a simulation. A simulation
similar to the local one is started. All changes which will be done in the run-
ning simulation will be done directly on the flash.
To run a flash as a simulation Tools ► Simulation ► Start simulation
from flash needs to be selected. In the dialog the flash drive can be se-
lected and the simulation started.
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Fig. 10-23: Start simulation from flash
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11 Update software
u-create studio provides to execute an update of the software directly via the
tool.
Therefore a log in on the control must happen. Then the control settings are
opened via double-click on the control node in the project tree.
Via "Software update" on the area "Info" can be checked if there is new soft-
ware available. If this is the case this is shown in a dialog and a software up-
date can be executed.
Add/Remove software
Furthermore additional Linux packages can be installed or removed on the
control via "Add/Remove optional features" in the area info. Thereby the soft-
ware selected in the dialog will be installed and the software which is not se-
lected will be removed if installed on the control.
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12 Load firmware on device
There is the possibility to install the firmware on a device (e.g. control) via a
removable disk. Thereby, the whole control operating system, the runtime
system and the application is stored on the removable disk and can be in-
stalled on any number of devices.
Therefore the following configuration settings have to be inserted in u-create
studio in the menu Tools ► Optionen... under Software Service:

Name Value
Update Server localhost

System
System version which should be installed on
the control or the active static operating
panel

To create a removable disk disk it must be plugged into the PC. Then Cre-
ate Target has to be selected in the context menu of the device in the
project tree and the following dialog opens:

Fig. 12-24: Dialog - Create Target

Name Description
Name: Name of the control

Description: Individual description
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Name Description

Destination:

Selection of the removable disk or any folder.

If no removable disk is selected, a warning
will be shown and the content is saved in the
selected directory.

If a removable disk is selected, it is checked
whether the removable disk is a valid Service
Medium. If it is no valid Sevice Medium, a
warning is shown and the removable disk
can be made valid or bootable via clicking on
"Prepare Service Medium (Administrator priv-
ileges required)".

Save relative path: If this option is activated, the path will be
stored relative to the project

PLC Name: Name of the control or the active static oper-
ating panel

DHCP: Use of a DHCP server

IP address: IP address of the control or the active static
operating panel

Subnet mask: Subnet mask

Default gateway: Gateway

Optional packages can be used to select additional software components
(e.g. OPC-UA). By checking the box for the desired package and OK it will
be saved on the removable disk and is available for installation.
A further dialog is opened via Compatibility settings, in which a range of
serial numbers can be set using "Add". This means that the firmware on the
removable disk can only be installed on the devices whose serial numbers
lie within this range. This prevents accidental installation on the wrong de-
vice.
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Fig. 12-25: Dialog - Compatibility settings

After all settings are made, the software can be stored on the removable
disk via "Create" (dialog "Create target"). Therefore, the removable disk is
available for the installation of the firmware on the desired devices.
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13 Manage devices
u-create studio provides the possibility to manage devices on a removable
storage device, to change network settings of devices. Furthermore, all set-
tings of the removable storage device can be deleted and the removable
storage device can be formatted, so that it can be used as conventional re-
movable storage device again and is not bootable any more.
Therefore Tools ► Manage Targets must be selected in the menu bar. The
following dialog is opened:

Fig. 13-26: Manage devices

Name Value
Destination Selecting the removable storage device

Relative path If this option is activated, the path will be in-
serted relative to the project

Trigger status report Function not available

Area Service Stick Sertings
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In this area a device can be selected as default device for a restore at de-
vices with a 7 segment display. In addition, in this area all device configura-
tions of the selected USB stick can be deleted and the stick can be format-
ted newly.

Name Value

Default target
Selecting a device which should be default
when restoring a backup on a device with a 7
segment display

Format Delete and newly format the USB stick

Available Targets/Backups
In this area devices on the USB stick can be deleted, added or a device from
the USB stick can be simulated.

Name Value
Porting a device configuration from the PC to
the USB stick

Delete selected device on the USB stick

Function not available

Device Properties
This area contains information about the device selected in Available Tar-
gets/Backups. Furthermore, network settings can be changed for the se-
lected device.

Name Value
Name Name

Description Optional description of the device

Created on Creation date of the device

Compatibility settings Open the compatibility settings (see Create
target USB stick)

PLC Name Name of the device

DHCP Use of a DHCP server

IP address IP address of the device

Subnet mask Subnetmask

Default gateway Gateway

Undo changes Reset all changes
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14 Prepare Service Medium
u-create studio offers the option to prepare a removable disk for the backup
of a control or to restore the saved backup on a control. To do so, a remov-
able disk with a memory of at least 2 GB is needed, which is plugged into
the PC.
Use the menu item Tools - Prepare Service Medium to open a dialogue in
which you have to select a removable disk.

Fig. 14-27: Prepare Service Medium

Information
The removable disk must never be pulled out during the writing process! It
is recommended to execute the command "Eject Device" under Windows
before removing the removable disk.

The backup or restore can be performed via "DevAdmin".



Configuration

44

15 Configuration
The following chapters describe the configuration options in the system.

15.1 Configuration of the message system

The message system is used to inform the user about processes in the con-
trol, which either can no longer guarantee a correct function or signal impor-
tant status changes in the control process.
The message editor is opened in the project tree via Message Editor.

15.1.1 Message Editor
Proprietary messages can be created and edited in this editor. These mes-
sages can be displayed in the message monitor.

Fig. 15-28: Message Editor

Messages can be created via "Add" or deleted via "Remove". When creating
a new message, a component ID and message ID are allocated automati-
cally, which can be manually changed later. Each message is identified by a
unique combination of component ID and message ID, therefore, each com-
bination must only exist exactly once.
The behavior of the messages is specified via the two pulldown menus
"Storage" and "Interaction".

Information
● Only component IDs between 100 and 999 may be created.
● Only Message IDs equal 1 or greater may be created.

Component ID
Unique number for a functional component from the control application. This
number is entered when the message is created and must be stated when
calling SetMessage in the application program.

Message ID
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Unique number for a message. This number must be indicated when calling
SetMessage. Since the same message with the same message text but dif-
ferent parameters can be called multiple times in the application program, it
must be identified there in a unique manner by an instance number.
Message text
The message text entered here is attached to the message when it is called
by SetMessage. Message texts can include placeholders in order to use
them to indicate current values applicable at the time of the function call.
Placeholders are intended for the instance number and for parameters within
the message text.
The format specification can be inserted into the text in any manner. It al-
ways starts with a '%' sign and needs to end with an empty space.

Storage

Setting Meaning
Alarm + Report Category Alarm and Report

Alarm only Category Alarm, message can be acknowl-
edged

Report only Category report

None No categorization, message is not displayed
on the message monitor

Interaction

Setting Meaning

ACK and Reset The message is only deleted if it has been
acknowledged and reset.

ACK or Reset The message is deleted if it either has been
acknowledged or reset.

Acknowledge

Message is deleted by acknowledging it.
Typical for messages, that the operator must
see and take into consideration. The ac-
knowledgment can take place from the appli-
cation program (QuitMessage).

Inactive
The message is inactive and is not displayed
in the alarm mask. From remote message is
only entered in the info log.

Reset

Message is deleted via resetting. Typical for
messages, which are only processed by the
application and that are not seen by the user
or must not be acknowledged (e.g. entries in
the report buffers and thereby display in full
the info log). The resetting of the message
takes place at the function ResetMes-
sage.

The following graphic indicates the status model of the messages including
the possible status transfers depending on the configured treatment options.
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Fig. 15-29: Status model for the messages

15.1.2 Export/import message texts
Via "CSV Export", the currently displayed messages can be saved in a sepa-
rate file. Via "Version Code", the file can be given a version ID. Via "CSV Im-
port", already created messages can be imported into the current project.
Messages from the device can be imported into the project by using "Im-
port". Hereby only messages of the applikation will be imported. Messages
of the base system will not be imported.

Information
At "CSV Export" the parameter "Storage" and "Interaction" will not be ex-
ported. Therefore they can not be restored at a later "CSV Import".

Information
Under Project ► Projects Settings ► Language Settings  the language
of the displayed messages can be switched.
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15.1.3 Translate messages
The created, currently displayed messages can be translated into another
language. To do so, a proprietary program (Translator) is pulled up with
"Translate". For more information about the operation: See online help of the
translator program.

15.2 Configuration of modbus server

To communicate with the modbus server on the control the following config-
uration entries must be set via "Expert Entries" directly on the node control:
[ModBus]
    enableRTU = 0 

    [ModBus.RTU]
    SIO_NAME = "/dev/ttyS1" 
    BAUDRATE = 19200
    PARITY = "N" 
    DATABITS = 8 
    NRSTOPBITS = 2 
    SERIAL_MODE = 0 // RS232 = 0; RS485 = 1

    [ModBus.TCP] 
    IP = "127.0.0.1" // IP address of control
    PORT = 502

The IEC variables, which are shared with the modbus server must be re-
leased first. After that they can be registered at the modus server via the
"Expert Entries" configuration. The following entries must be added:
[ModBusReg] 
    MaximumModBusAddress = 100 // max. Anzahl an Variablen

    [ModBusReg.Adr:1]
        Factor = 1.0 
        Variablenname = "APPL.Application.GVL.var1" 
        WritePermission = 0 

    [ModBusReg.Adr:2] 
        Factor = 1.0 
        Variablenname = "APPL.Application.GVL.var2" 
        WritePermission = 1
    ...

    [ModBusReg.Adr3:1:200] //Array: [<startindex>:<endindex>]
        Factor = 1.0 
        Variablenname = "APPL.Application.GVL.var_array1" //Array1 1:200 
        WritePermission = 0
    ...

Information
To call released variables via Modbus server the server must be restarted.
This must be done mandatorily in the application via function
"MODUS_Restart()" of the library "K_Modbusbase".
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15.3 Configuration of EtherCAT devices

In principle, EtherCAT devices can be configured as "EtherCAT Master" or
"EtherCAT Slave". Several EtherCAT Slave devices can be connected to a
EtherCAT Master (e.g. the control functions as master and can be con-
nected with slaves).

15.3.1 Configuring EtherCAT Master
Open the configuration window by double-clicking on the EtherCAT node.
The EtherCAT Master configuration window consists of the following tabs:
● EtherCAT Master
● Status
Tab "EtherCAT Master"
The general master configuration can be carried out here.

Element Meaning

Timing mode
● Cycle time: Insert a cycle time in μs.
● Task: Select a configured task

Activate cross-
communication Activates cross-communication between drives and encoder box.

Cross-communi-
cation cycletime Cycletime of the cross-communication between drives and encoder box.

Simulation mode
The bus master can be set to "Simulated" to be able to carry out tests
without physical slaves. All slaves are then automatically set to "Simu-
lated".

The area Info shows information about the manufacturer and the device. The
remaining parameters of an EtherCAT Master can be found in the area "Ad-
vanced" in a tree structure. These parameters do not need to be switched for
normal operation.
Tab "Status"
Various analysis parameters are shown here, which provide information
about the EtherCAT bus of a running control.

ECAT

Element Meaning
Status Status information

Cycle time Current cycle time

Number of
slaves Number of connected slaves

Min. early start
offset Minimum of the send times of the "early"-frame relative to the systick

Max. early start
offset Maximum of the send times of the "early"-frame relative to the systick

Min. start offset Minimum of the send times of the "normal"-frame relative to the systick
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Element Meaning
Max. start offset Maximum of the send times of the "normal"-frame relative to the systick

Max. start time DMA statistics: the maximum time before the first data is available
(graphical representation available by clicking the button)

Max. read time DMA statistics: the maximum time of an DMA transaction (graphical rep-
resentation available by clicking the button)

Bus statistics

Element Meaning

Bus analysis

With the two buttons "Start/Stop" and "Reset"
the bus analysis can be controlled. As the re-
sult of the bus analysis the following parame-
ter can show values.

Lost frames Number of lost frames (graphical representa-
tion available by clicking the button)

Early update jitter Maximum undercut of the cycle time when
sending "early"-frames

Update jitter Maximum overstep of the cycle time when
sending "normal"-frames

Utilization Average utilization of the communication
medium in %

Cyclic Utilization Average utilization of the communication
medium by cyclic communication in %

DC deviation
Deviation of the DC system time (all slaves)
(graphical representation available by click-
ing the button)

Min. DC deviation Minimum deviation of the DC system time (all
slaves)

Max. DC deviation Maximum deviation of the DC system time
(all slaves)

In the list "Bus messages" are the messages regarding the bus since the last
start of the PLC listed. This makes it easier to find messages for diagnostic
purposes.

15.3.2 Possible data failures on EtherCAT Bus
By usage of a control with a hardware EtherCAT controller it has to be taken
care of a correct configuration of the EtherCAT controller. Otherwise error
messages due to timing problems can occur.
On controls with hardware EtherCAT controller the EtherCAT interfaces are
marked with "ECAT[x]". On controls without hardware EtherCAT controller a
standard network interface (Ethernet[x]) is configured for EtherCAT.
The EtherCAT controller takes care of the following areas of responsibility:
● Arranging EtherCAT data packages
● Sending and receiving EtherCAT data packages on the bus
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EtherCAT master and EtherCAT controller have a common area in the RAM
for data transfer. There the EtherCAT master saves the data to send and
gets the data to receive. The EtherCAT controller has (as usual for network
controller) direct access to the common RAM area (Direct Memory Access)
and transfers the data immediately to the EtherCAT bus (RAM transfer). So
a data stream between RAM and EtherCAT bus is created.
The following parameter in the area "Advanced" under "Advanced parame-
ter" have influence on the correct operation of the EtherCAT controller:

Parameter Description
DMA duration (dmaTime) Time which is available for RAM transfer

Offset of standard frame (startOffset) Point in time where the normal process data
in the RAM are ready for collection

Offset of early frame (earlyStartOffset) Point in time where the data for "fast control"
in the RAM are ready for collection

Fig. 15-30: Timing diagram

1  ... Offset of standard frame 2  ... DMA duration
3  ... EtherCAT cycle time

The following conditions apply:
● The write operation of the EtherCAT master in the RAM buffer must be

carried out before the first read operation of the EtherCAT bus from the
RAM buffer.

● The read operation must be completed within the configured DMA dura-
tion. By default a time value of 50 µs is configured to establish the data
stream between RAM and EtherCAT bus (RAM transfer). In rare cases
some dynamic influencing factors (e.g. CPU load, RAM load, ...) can
lead to a transfer time exceeding the configured time.

Regardless of the current cycle, the following formula must be taken into ac-
count:
(Offset of standard frame + DMA duration + Frame runtime) <
EtherCAT cycle time
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15.3.2.1 Telegram losses
If a telegram loss is detected on the EtherCAT bus, a message is reported.
Depending on the value of the configuration parameter frameLossToler-
ance, this message is reported either as an error or as a warning.

The message is reported as a warning if the number of telegram losses in
the last ten transmissions has not exceeded the telegram loss tolerance con-
figurable by the configuration parameter frameLossTolerance. If several
telegrams are transmitted per bus cycle, all telegrams are included for the
tolerance limit, i.e. if, for example, five telegrams are transmitted per bus cy-
cle, the tolerance limit is reset after two successfully transmitted bus cycles.
The error status of the end points affected by the process data is not
changed. The process data of the affected end points are not updated in this
cycle.
WARNING Ackn (6353/72), ECAT: At least one Ethernet frame was
lost in the EtherCAT segment.

If it occurs repeatedly with exceeding of the tolerance limit, the message is
sent as an error.
ERROR Ackn (6353/2), ECAT: At least one Ethernet frame was
lost in the EtherCAT segment.

The error status of the end points affected by the process data are only set
invalid if the cyclic command present in the affected telegram is not transmit-
ted several times in succession and the telegram losses tolerance has been
exceeded.

15.3.2.2 Timing problems
If a timing problem is detected on the EtherCAT bus, a message about the
time violation occurs. Possible causes are:
● 'DMA': The configured DMA duration (dmaTime) was exceeded. Not all

data could be read from the RAM buffer within the specified time.
● 'SW normal': The time required for the update in the control context was

higher than the offset of the standard frame (startOffset). No data could
be written into the RAM buffer.

● 'SW early': The time required for the update (especially the application
code for fast control) in the control context was higher than the offset of
the early frame (earlyStartOffset).

The cause of the time violation is visible as a parameter in the error text.
If a timing violation occurs, all further telegrams whose transmission was
scheduled for this cycle after the affected telegram are also invalid. The re-
sulting failure of several telegrams in one cycle is counted as one timing vio-
lation.
If no timing violation has occurred within the last ten EtherCAT bus cycles,
the message is reported as a warning. The error status of the end points af-
fected by the process data is not changed. The process data of the affected
end points is not updated in this cycle.
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WARNING Ackn (6353/73), ECAT: Timing violation occurred (DMA)
WARNING Ackn (6353/73) ECAT: Timing violation occurred (SW normal) 
WARNING Ackn (6353/73) ECAT: Timing violation occurred (SW early)

If timing violations occur repeatedly within ten EtherCAT bus cycles, the
message is sent as an error and the error status of the end points affected
by the process data is set invalid.
ERROR Ackn (6353/55), ECAT: Timing violation occurred (DMA)
ERROR Ackn (6353/55) ECAT: Timing violation occurred (SW normal) 
ERROR Ackn (6353/55) ECAT: Timing violation occurred (SW early)

Error handling "DMA"

In case of a DMA error, the following steps can be taken to determine the
optimum setting for the dmaTime parameter:

1) Set dmaTime to a value twice of the current value (e.g. 100 µs).
2) Under Diagnostics ► Cyclic DMA statistics activate DMA statistics by

setting the checkmark.
3) Operate the system some time with high load.
4) Connect or trigger a status report.
The DMA statistics must be evaluated to calculate the correct settings. The
recorded DMA statistics can be found online in the "Status" tab of the Ether-
CAT bus or in the status report in the "IoStaRep.log" file in the "PLC" folder.
The parameter dmaTime must be set at least 10 µs greater than the value of
"Max. start time" of DMA statistics (tab "Status") or the value of "Maximum
time" in area "Cyclic DMA read statistics" of the status report.

Error handling "SW normal"

The parameter startOffset must be configured greater than the value of
the parameter "Max. start offset" in the "Bus information" section of the "Sta-
tus" tab or value of "Max systick delay" in area EtherCAT master" in the file
"IoStaRep.log" of the status report.

Information
If the value is greater than the configured bus cycle time, the cycle time
must be adapted correspondingly.

Error handling "SW early"

The parameter earlyStartOffset is only relevant if a fast control is oper-
ated. In this case, the value must be greater than the value of the parameter
"Max. early start offset" in the "Bus information" area of the "Status" tab or
value of "Max systick delay (early)" in area EtherCAT master" in the file
"IoStaRep.log" of the status report.
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Information
If the value is greater than the configured bus cycle time, the cycle time
must be adapted correspondingly.

15.3.2.3 Consequence
An increment of these times has the following consequences:
● Reduction of the amount of data which can be transmitted on the bus,

because the time available for transmission is reduced.
● Reduction of the time between "reading inputs" and "writing outputs" at a

configured "fast control".
● Possibly necessary higher bus cycle time.

15.3.3 Configuring EtherCAT Slave
A new EtherCAT slave is attached to the existing EtherCAT Master node.
To do so, proceed as follows:
1) In the project tree at the node of the EtherCAT Master open the context

menu of a port (DRV0 or OUT0) and select Add Device.
2) In the open dialogue "Add Device" select an EtherCAT slave device and

click on Add Device.
3) Double-click on the newly inserted EtherCAT slave device in the project

tree.
An EtherCAT slave device has been inserted and the configuration window
opens. Depending on the insterted device, the configuration possibilities in
this window differ.
The configuration window for EtherCAT slave devices consists of the follow-
ing tabs:
● Basic Configuration: This tab displays the name of the device type and

allows the configuration of the basic settings.
● I/O Mapping: IEC variables can be mapped to endpoints. See also "Map-

ping Endpoints".
● FMMU/Sync: Under this, the settings for "Fieldbus Memory Management

Unit" and "Sync Manager" can be carried out.
● Start Parameters: Start parameters are set with the slave for each boot.
● Status: Shows information about the status of the slave device.
The following tabs are only visible when the expert settings have been acti-
vated:
● Expert Mode Process Data: Expert settings for the cyclical process data.
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Tab "Basic Configuration"

Like for all configuration windows, the structure for EtherCAT slave devices
is split into three parts "General", "Info", and "Advanced". For normal opera-
tion parameter of part "Advanced" need not to be changed. Furthermore, the
area "General" is also split into the areas "Device Identification", "Distributed
Clock" and "Sync".

Fig. 15-31: Part "General"

General

Element Meaning

Timing mode

● Cycle Time: Insert a cycle time in μs. The value must be a multiple
of the masters cycle time.

● Master: Cycle time of the master is adopted.
● Task: Selection of a configured Task
● Reduction: Regarding to the cycle time of the master, those of the

configuring device will be slowed by the selected factor.

Fast Control Activates fast control for in-/outputs of the module

Expert Settings Activates expert settings. If activated, further tabs ("Expert Prozess
Data") are available.

Availability

EtherCAT slave devices can be configured so that they do not always
have to be physically present in order to be able to perform tests. The fol-
lowing selection options are available for that:

● Mandatory: The availability of the device is mandatory
● Optional: In the setting, the operation with and without existing slave

devices possible, while the device is actually controlled if it is
present.

Simulation mode

● Not simulated: Device is connected and controlled.
● Simulated (slave not plugged in): The interfaces to slave devices are

controlled in the simulation.
● Simulated with hardware (slave plugged in): In this case, the slave

device is not controlled even though it is present. This allows to still
perform tests with a complete structure without the risk to control the
connected devices.
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Fig. 15-32: Part "Device identification"

Device identification

Element Meaning
Activate Device
Identification This activates the function and releases the necessary parameters.

Identification
Mode

Assign identification ID to slave so that the EtherCAT master knows the
order of the added devices (will not be written on slave).

The following options are available for selection:

● Configured Station Alias: To identify the device the configured Sta-
tions ID is used.

● Requesting ID mechanism: Identification ID is configured at the de-
vice (e.g. via DIP switch).The address offset 134 is used here.

● User-defined Address Offset: Any address offset can be indicated
here. Which setting needs to be carried out here, can be found in
the documentation of the EtherCAT slave device.

Address Offset Is only configurable if the identification mode "User-defined Address Off-
set" is used.

Station ID
Station Alias of the EtherCAT slave device for unique localization of the
device on the EtherCAT bus (0: Position of the device on the bus will not
be checked).

For certain use cases it is necessary to assign an additional address - the
"Device identification value" - to an EtherCAT slave device. This address can
either be configured at the device via DIP switch or it can be written as "Sta-
tion Alias" to the EEPROM of the device. This is to localize the devices on
the bus. The assigning of this address is necessary for the following use
cases:
● Use of several similar EtherCAT slave devices on the bus whereat the

order of this devices is important for the function of the system. During
the bus scan it can be recognized if devices are interchanged.
Use of several similar EtherCAT slave devices on the bus whereat at
least one of the devices is optional. During bus scan it is recognized on
which position which optional device is connected or not connected. So
the correct order of the devices is maintained.

The Station Alias for an EtherCAT slave device can be configured via u-cre-
ate studio.
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Information
Some EtherCAT slave devices (without EEPROM) do not support to save
the Station Alias.

Fig. 15-33: Part "Distributed Clock"

Distributed Clock

Element Meaning
Activate DC With this you can set whether Distributed Clock is to be used.

Use Automatic
DC

When using this option, the "Sync 1" is automatically calculated by the
system. Therefore, in this case the settings for "Sync 1" also deactivated
in the "Sync" area.

Pre-defined DC
The selection is determined through the ESI file of the slave. Additional
information can therefore be found in the documentation of the slave de-
vice.

Fig. 15-34: Part "Sync"

Sync

Element Meaning

Sync 0 / Sync 1

This allows to activate the two Sync separately.

However, if the option "Use Automatic DC" is activated, the parameters of
"Sync 1" can no longer be configured manually.

How the two Sync are to be used can be found in the documentation of
the EtherCAT slave device manufacturer.

Sync Cycle Unit Here, you can select between a specific cycle time and a multiple of the
slave cycle time for the configuration.
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Element Meaning

Cycle Time Cycle time in µs or multiple of slave cycle time, depending on the config-
ured Sync cycle unit.

Time Delay Indicates the time between the Sync impulse of control and the Sync 0/1
point in time on the device.

Tab "I/O Mapping"

In this tab the endpoints can be mapped to a device (see chap. "Mapping
endpoints").
The tab I/O Mapping is opened via the configuration window of a module
and offers the option to permanently override its endpoints for the runtime
(forcing).
Therefore, you can enter the desired value in the column "Force Value" and
then activate the column "Force" with the help of the slider. As long as the
value is activated with the slider, the endpoint maintains the set value.

Information
The values in the "Value" column are the values that the IEC application
assigns to the endpoints.

Tab "FMMU/Sync"

Detailed information about the topic "Fieldbus Memory Management Unit"
and "Sync Manager" can be found in the official EtherCAT documentation.

Tab "Start Parameters"

Detailed information about the topic "Start Parameters" can be found in the
official EtherCAT documentation.

Tab "Status"

On the tab "Status" you can see the information of the EtherCAT slave de-
vice concerning the runtime.

Element Meaning

Status Information whether everything is OK or whether there are pending er-
rors.

E2PROM Name Device name

E2PROM Ver-
sion Device version

Serial Number Serial number

Order Number Order number

Device Number Device type number

Print Number Print number
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Element Meaning
Firmware Ver-
sion Firmware Version

Hardware Revi-
sion Hardware Revision

First operation
date Delivery time

Operation time Operating hour count

ECAT state State of the slave

Active ECAT
transition Active ECAT transition

AL status code AL status code for transition

AL status code
description AL status code description

In the list "Device messages" are the messages of the device since the last
start up listed.

Tab "Expert Mode Process Data"

Detailed information about the topic "Process Data" can be found in the offi-
cial EtherCAT documentation.

Tab "EoE Settings"

When the EtherCAT slave offers Ethernet over EtherCAT (EoE), the neces-
sary settings can be carried out here.
Since no MAC addresses are necessary for the EtherCAT protocol but for
Ethernet they are, a Virtual MAC ID must be set for a slave.

Fig. 15-35: EoE Settings

IP Settings

Designation Meaning
IP Address Indication of the IP address for the visualisation communication
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Designation Meaning
Subnet mask the corresponding subnet mask

Default Gateway the standard gateway

DNS Server Address of a DNS (Domain Name System) server

DNS Name Name of a DNS (Domain Name System) server

15.4 Configuration of CAN devices

In principle, CAN devices can be configured as "CAN Master" or "CAN
Slave". Several CAN Slave devices can be connected to a CAN Master (e.g.
the control functions as master and can be connected with slaves).

15.4.1 Configuring CAN bus
Tab "Basic Configuration"
Via double-clicking a CAN bus the configuration window opens, which is de-
vided into several parts. The part "General" is structured as follows:

Fig. 15-36: Part "General"

Element Meaning

Timing Mode

● Cycle Time: Insert a cycle time in μs. The value must be a
multiple of the masters cycle time.

● Task: Selection of a configured Task
● Reduction: Regarding to the cycle time of the master,

those of the configuring device will be slowed by the se-
lected factor.

Simulation mode

● Not simulated: Device is connected and controlled.
● Simulated: In this case, the device is not controlled even

though it is present. This allows to still perform tests with a
complete structure without the risk to control the connected
devices.

Baudrate Baudrate in kBaud for data transmission on the bus.

Information
Minimum cycle time of the CAN bus is 4000 μs. (e.g. EtherCAT cycle time:
1000 μs, 4 times reduced CAN bus cycle time: 4000 μs).

The part "Info" shows information about the manufacturer and the device.
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In the part "Advanced" you can find further parameters of the CAN bus in a
tree structure. For normal operation this parameters need not to be changed.
Tab "Status"
Various analysis parameters are shown here, which provide information
about the CAN bus of a running control.

Element Meaning
Status Status information

Message Send Count Number of sent data

Message Receive Count Number of received data

Bad Send Count Number of defective sent data

Bad Receive Count Number of defective received data

Baudrate Baudrate (kBaud)

Message Filter Count Number of filtered data

Tx Error Level Tx-error counter (Transmit)

Rx Error Level Rx-error counter (Receive)

Bus Status Bus status

Sent Data Bytes Sent data bytes

Received Data Bytes Received data bytes

Error Frame Count Number of error frames

Error Warning Count Number of warnings

Error Passive Count Number of error passive

Bus Off Count Number of bus offs

Data Overrun Count Number of data overruns

15.4.2 Configuring CAN Master
To configure the device as CAN Master (Adding the function CANopen Mas-
ter), proceed as follows:
1) Open the context menu of a CAN interface and select ►  Add de-

vice ....
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Fig. 15-37: Add CAN Master

2) Select category ► "CANopenManager", device ► " CANopenMaster"
in the open dialog and confirm with "Add device".

The CAN Master node is assigned to the CAN interface of the device.
Double-clicking the CAN node opens the configuration dialog.
Tab "CANopen Master"
In this tab the general master configuration can be carried out.

Fig. 15-38: CAN Master configuration dialog

Element Meaning

Node address
Selecting a unique node address of the pre-defined node area.
It serves to ensure, that the configured device is the same as
the physical device.

The part "Info" shows information about the manufacturer and the device.
In the part "Advanced" you can find further parameters of the CAN Master in
a tree structure. For normal operation this parameters need not to be
changed.

15.4.3 Configuring CAN Slave

15.4.3.1 Configuring CAN Slave device
A new CAN Slave is attached to the existing CAN Master node.
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To do so, proceed as follows:
1) Open the context menu of the CAN Master in the project tree and select

Add Device.
2) Select a CAN Slave device in the open dialog and confirm with Add De-

vice.
A CAN Slave device has been inserted.
Double-clicking the CAN Slave device in the project tree opens the configu-
ration dialog. The configurationpossibilities in this window depends on the
device inserted.
The configuration window for CAN Slave devices consists of the following
tabs:
● Basic Configuration: This tab displays the name of the device type and

allows the configuration of the basic settings.
● I/O Mapping: IEC variables can be mapped to endpoints. See also "Map-

ping Endpoints".
● Service Data Objects: Configuration of SDOs (Service data objects).
● PDO Mapping: Mapping of send and receive PDOs (process data ob-

jects).
● Status: Shows information about the status of the slave device.
The following tabs are only visible when the expert settings have been acti-
vated:
● Receive PDO Mapping: List of all PDOs, which can be received.
● Send PDO Mapping: List of all PDOs, which can be sent.
Tab "Basic Configuration"
This tab is structured into the parts "General", "Info", "NMT", "Heartbeat",
"Node Guarding" and "Advanced".
The part "Info" shows information about the manufacturer and the device.
The part "Endpoint configuration" is only visible if the CAN slave has inputs
and outputs.
If NMT mode is set to "System", the parts "NMT" and "Hearbeat" appear.
By activating "Expert settings", the part "Node Guarding" appears, in which
the node guarding can be configured.
For normal operation the parameters of the area "Advanced" need not to be
changed.
General
Basic settings can be configured in the part "General".
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Fig. 15-39: Part "General"

Element Meaning

Timing Mode Cycle time of the Slaves. Only for selected Slaves a cycle time
differently to the Master can be configured (e.g. BL210).

Expert settings Activate expert settings for additional configuration.

Availability

CAN Slave devices can be configured so that they do not al-
ways have to be physically present in order to be able to per-
form tests. The following selection options are available for that:

● Mandatory: The availability of the device is mandatory.
● Optional: In this setting, the operation with and without ex-

isting slave devices possible, while the device is actually
controlled if it is present.

Simulation mode

● Simulated (slave not plugged in): The interfaces to slave
devices are controlled in the simulation.

● Simulated (slave plugged in): In this case, the slave device
is not controlled even though it is present. This allows to
still perform tests with a complete structure without the risk
to control the connected devices.

Node address
Selecting a unique node address of the pre-defined node area.
It serves to ensure, that the configured device is the same as
the physical device.

NMT mode
Control of the status transmission via system or application.

Via activating system, the parts NMT and Heartbeat appear.

Enable LSS Expert settings for configuration of the node-ID via LSS.

Enable LMT Expert settings for configuration of the node-ID via LMT.

Configure Endpoints and PDOs
The part "Configure Endpoints and PDOs" is only visible, if the CAN slave
has in-/outputs.
By pressing Configure Endpoints the following configuration dialog opens,
which consists of the tabs "Input" and "Output".
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Fig. 15-40: Configuration dialog "Endpoint configuration"

In this tab it is possible to separate the memory range of a PDO to several
inputs and outputs. So the data of the PDO can be processed in different
ways and can be used at the I/O mapping separately.
In the respective tab all configured PDOs with the inputs and outputs are
listed. For each inputs or output an unique name as well as the data type
can be configured. Depending on the size of the PDO inputs and outputs
can be added via Add. Via Remove inputs or outputs can be removed.
Via Restore defaults the configured inputs and outputs can be reset. This
step is irreversible.
By pressing Configure PDOs the following configuration dialog opens:
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Fig. 15-41: Configuration dialog "PDO configuration"

In this dialog it is possible to configure the parameters Timeout and Mes-
sage Loss Tolerance for each PDO that is transmitted from the slave to the
master.
The parameter Timeout defines the allowed time from the start of the device
until the master receives the first PDO. If this time is exceeded an error is
triggered. The default value is tem times the cycle time of the device.
The parameter Message Loss Tolerance defines the allowed number of con-
secutive lost PDOs. If this number is exceeded an error is triggered. The de-
fault value is 0.
NMT
Control of the state can be configured in the part "NMT" (network manage-
ment).

Fig. 15-42: Part "NMT"

Element Meaning
Reset mode Time, if the reset of the node should be executed

Reset delay Duration of waiting time after restarting a node

Heartbeat
Sending heartbeats can be configured in the part "Heartbeat". By selecting
"Heartbeat Consuming" the monitoring of heartbeats can be configured in
the window which opens.
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Information
Activating the hearbeat function is only possible, if node guarding is not ac-
tivated.

Fig. 15-43: Part "Heartbeat"

Element Meaning
Activate Heartbeat Activating heartbeat function

Heartbeat cycle time Interval between consecutive heartbeats (in s)

Fig. 15-44: Configuration dialog hearbeat monitoring

Element Meaning
Enable Activates the consuming of the node address.

Node ID of Producer Unique identification of the heartbeat producer on the bus.

Consumer Times Interval between consecutive heartbeats (in ms).

Node Guarding
Node guarding can be configured in the part "Node Guarding".

Information
Activating node guarding is only possible, if the hearbeat function is not ac-
tivated.

Fig. 15-45: Part "Node Guarding"
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Element Meaning

Activate node guarding Activating cyclic node guarding of the slave. Is only possible, if
heartbeat is not activated.

Node guarding time
Time, with which the node guarding of this device should be ex-
ecuted. Must be an integer multiple of the CAN- and PDO-cycle
time of the device.

Life time factor If the factor is unequal 0, the slaves checks the master for fail-
ures.

Tab "I/O Mapping"
In this tab the endpoints can be mapped to a device (see chap. "Mapping
endpoints").
The tab I/O Mapping is opened via the configuration window of a module
and offers the option to permanently override its endpoints for the runtime
(forcing).
For that, you can enter the desired value in the column "Force Value" and
then activate the column "Force" with the help of the slider. As long as the
value is activated with the slider, the endpoint maintains the set value.

Information
The values in the "Value" column are the values that the IEC application
assigns to the endpoints.

Tab "Service Data Objects"
In the tab "Service Data Objects" automatically generated SDOs can be con-
figured and SDOs can be created manually.

Fig. 15-46: Service data objects
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The configured SDO will only be transmitted, if "Download" is selected. If
"Abort if Error" is selected, the initialization of the slave will be aborted in
case of a defective SDO.
Via "Add" new SDOs can be created and the manually created SDOs can be
deleted via "Remove". Manually created objects can be sorted with "Up" and
"Down" to change the transmission sequence.
Tab "PDO Mapping"
Mapping for send and receive PDOs is defined in the tab "PDO Mapping",
which means the assignment of inputs and outputs (object directory entries)
to a PDO for data exchange in the CAN bus.

Fig. 15-47: PDO Mapping

Mapping for send and receive PDOs is defined in the tab "PDO Mapping",
which means the assignment of inputs and outputs (object directory entries)
to a PDO for data exchange in the CAN bus.
PDOs can be individually activated or deactivated, which prevents sending /
receiving. Only PDOs which are activated in PDO Mapping are shown in the
tab "I/O Mapping" where they can be assigned to variables.
Tab "Status"
In the tab "Status" you can see the information of the CAN Slave device con-
cerning the runtime.

Element Meaning
Status Status information

E2PROM Name Device name

E2PROM Version Device version

Hardware Revision Hardware revision

Function Variant Information re. design

Print Number Print number

Firmware Version Firmware version

Serial Number Serial number

Order Number Order number

Device Number Device type number

IBN Time Delivery time

Run Time Operating hour count
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15.4.3.2 Configuring control as CAN Slave
To configure a control as CAN Slave (Adding the function CANopen Local
device), proceed as follows:
1) Open the context menu of the CAN interface and select ► Add Device
2) Select category ► "Local Device / ► CANopen Local Device"in the

dialog and confirm with "Add device".

Fig. 15-48: Insert CAN Slave

Information
The device itself is called "local device", if it serves as master and is also
configured as slave.

Via double-clicking local device the configuration window opens, which con-
sits of the following tabs:
● Basic Configuration: This tab displays the name "Local Device" and al-

lows the configuration of the basic settings.
● I/O Mapping: IEC variables can be mapped to endpoints. See also "Map-

ping Endpoints".
● Object Editor: Configuration of in-/outputs and SDO parameters.
● Status: Shows the status of the slave device.
Tab "Basic Configuration"
This tab is structured into the parts "General", "Info", "Generate Description
File" and "Advanced".
For normal operation, parameters of part "Advanced" need not to be
changed.
The part "Info" shows information about the manufacturer and the device.
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General

Fig. 15-49: Part "General"

Element Meaning

Availability

If the device is used as slave it can be configured so that the
master not always have to be physically present in order to be
able to perform tests. The following selection options are avail-
able for that:

● Mandatory: The availability of the master is mandatory:
● Optional: In this setting, the operation with and without ex-

isting master device possible, while the device is actually
controlled if it is present.

Node address
Selecting a unique node address of the pre-defined node area.
It serves to ensure, that the configured device is the same as
the physical device.

Device Identification

Fig. 15-50: Part "Device Identification"

Element Meaning
Device Type Profile of the device

Device Name Name of the device at the bus

Product code Identification code of the device

Revision number Version of the device

Generate description file

Fig. 15-51: Part "Generate Description File"
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To use the device as CAN Slave, all parameters have to be completely con-
figured. Via pressing "Generate file ..." a EDS-description file is generated,
which can be saved separately.

Information
The device description file must be installed manuallly so that the device is
available for use.

Tab "I/O Mapping"
In this tab the endpoints can be mapped to a device (see chap. "Mapping
endpoints").
The tab I/O Mapping is opened via the configuration window of a module
and offers the option to permanently override its endpoints for the runtime
(forcing).
For that, you can enter the desired value in the column "Force Value" and
then activate the column "Force" with the help of the slider. As long as the
value is activated with the slider, the endpoint maintains the set value.

Information
The values in the "Value" column are the values that the IEC application
assigns to the endpoints.

Tab "Object Editor"
On the tab "Object Editor" in- / outputs and SDO parameters can be config-
ured.
Add input / output
It is possible to add in- and outputs in the tab "Object Editor". Therefore the
button "Add" must be pressed. The following dialog appears:

Fig. 15-52: Configuration dialog add I/O

Element Meaning

Typ Define, if an input (master receives data from slave) or output
(master sends data to slave) should be created.
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Element Meaning
Name Insert unique name.

Count Select required length of the in-/output, length is limited.

Data Type Select data type.

Force new PDO Activate to use a separate PDO for the in-/output.

It is shown how many inputs (Tx) or outputs (Rx) are already configured.

Fig. 15-53: Number of used PDOs

Created inputs and outputs parameters can be deleted via "Remove".
Add SDO parameters
It is possible to add SDO parameters in the tab "Object Editor". Therefore
the button "Add" must be pressed. The following dialog appears:

Fig. 15-54: Number of used PDOs

Element Meaning
Typ Define if the parameter is readonly or writeable.

Name Insert unique name.

Count Select required length of the SDO parameter, length is limited.

Type Select data type.

Created SDO parameters can be deleted via "Remove".
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16 Diagnosis

In this chapter, the diagnostic options with u-create studio are described. A
diagnosis is only possible after logging into the control, since otherwise no
parameters/values are read from the control.
In the project tree the status of the devices and busses is indicated with a
corresponding icon.

Icon Meaning
Device or entire device node has no errors.

Device is optional and not connected.

An error has occurred in the device affected.

One or more devices in this node have an error

Device is simulated (Simulation mode = simulated)

An error has occured on an added device

Each individual control can be assigned its own diagnostic node with in-
cluded message monitor.

16.1 Message monitor

The pending alarms and messages for all the existing devices in the project
are displayed in the message monitor.
Double-clicking on Diagnostics - Messages in the project tree opens the
message monitor.
Messages of the respective category can be filtered via the "Alarm" or "Re-
port" buttons. (This categorization takes place during the setting up of a
message in the message editor.) If both categories should be shown
("Alarm" and "Report" both active) alarms are always shown first from latest
to oldest and then reports are shown from latest to oldest.
The messages view updates automatically by default. The automatic update
can be deactivated by activating "Manual". After that, an update of the mes-
sages can be triggered manually via "Update".
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Fig. 16-55: Message monitor

"Alarm" messages can be acknowledged via the context menu. Multiple se-
lections are possible.

16.2 Variable Browser

The variable browser displays the system variables of the IEC application.
Variables are only displayed if you are connected with the control and if you
are logged in. The variables are displayed in the variables browser, including
their directory structure.
The structure consists of the base node APPL, which contains the released
variables and SYS, which contains data of the system configuration (e.g.
SYS - CAT - IO - ONBOARD for hardware information, SYS - PERF for in-
formation about load of the CPU and the tasks, ...).
Right-clicking a node structure in the variable browser and pressing Update
updates the entire structure.
The variables can then be viewed in the watch monitor.

16.3 Watchmonitor

The watch monitor can be opened via View - WatchMonitor and it is used
to view and dynamically override variables for the runtime (force).
Variables can be inserted via Drag&Drop from the variable browser or via
"Add Variable ...". To do so, u-create studio must be connected with the con-
trol and must be registered.

Name Description
Update Update the selected variable

Delete Delete the selected variable

Delete all Delete all variables in the watch monitor

Add variable ... Add a variable

Import Import a variable list

Export Export the currently insert variable in a variable list
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Name Description

Set all default values Write values that were entered in the column "Predefined
Value" on the variable in the control

16.4 Trace

In the Tracemonitor the Trace of the control will be shown in an easy read-
able way. It can be opened by double click on Diagnostics - Trace.

Fig. 16-56: Trace

The trace can either be watched live from the control or a previously saved
can be opened by clicking "Open". For the live viewing is a login to the con-
trol required.
If "Autoscroll" is activated during "Live trace" allways the newest message
will be shown. This "Autoscroll" feature will automatically be deactivated
when clicking in the text area or manually by clicking the button.
For elements that can occur frequently filters can be defined in Tools - Op-
tions - Trace which can be activated or deactivated in Tracemonitor as de-
sired.
The search box on the top can be used to search for specific text. The usual
options like "Whole word" or "Match case", and also regular expressions,
can be used. If "Live trace" is activated then the search function is not avail-
able.
For better readability in Tools - Options - Trace colors can be defined and
also rules for marking of one or more lines which contains a specific text.
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